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METER ACCOUNTS ARE HERE

In the past BSD has sold SpecLink® solely by subscription, providing a SEBURHoNANTSATHNES
variety of catalogs to choose from. However, a significant percentage of Begairation | System Settings |
SpecLink prospects complete alimited number of projects per year and

find an annual subscription does not fit their budget. And SpecLink rc’;&:;téﬁm lem Bt

subscribersfrom timeto time need to use alimited number of SpecLink T Cataloos-

sections that are not included in their current subscription. The Meter [S0Uses Speel fnk+
Account is anew way to purchase SpecLink specification sections that S becription Effective Diles [~ Aechiectiaal
addresses these needs. A Meter Account allows you to pay for BSD [ Mo Cumer Subscrption I Shuchurd Engneesing
SpecLink, PerSpective and Short Form sections by the section as an Masler Darahase Effacive Dales: K LCholEnaaree 0

[T Lendscaps dechieciue

alternative to purchasing an annual subscription. It can also be used to [Fiow T, 2005 ToDiec 14, 2020 I MecharicalEloatrioal
supplement an existing annual subscription. Fregister Here [ The Basics

] ] Click ihe button o sutomaticaly ecister [ Civisond
Here's how it works. You purchase a Meter Account by contacting the e O eed volwe e
BSD Sales Department at 1-888-BSD-SOFT (273-7638). Youmust havean P e el o ||| PaiBpeciive
Internet connection to use a Meter Account. Once you purchase an need the Access [ shavwn abave. I™ Peifomance
account you receive an Electronic Invoice ID (EID) that isused to : _ L jSteniom
initialize the account on your local network or computer. Toinitialize, you Fiegistes Product Dntine |
simply start the software, click on the File menu and then Registration and T
Settings (Dialog Box, right). Click on the Register Product Online button, 2he Mater fizct Ho BF0S1

X . . Eubzcnption

enter your EID in the space provided and click OK. That's all you have to el B Metervabie: [ $266
do. When registration is complete you will see your Meter Account -
number and current value displayed in the dialog box. | W B

See* Meter Accounts’ on page 5
Dialog Box - Registration and Settings
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manufacturers about SpecLink usage than the statistical reports that are already being
generated.

Currently, BSD gathers data automatically from the computers of SpecLink subscribersthat
enable us to compile reports on the frequency of use of specific sections and the number of
times particular manufacturers have been specified. This statistical data does not identify
particular users or projects, so it is of interest primarily asatrend indicator and atool to
determine the relative popularity of specific products. BSD also uses this datato help
determine which sections should receive more maintenance attention.

With thewinter 2005-06 release of BSD SpecLink, our customerswill havethe optionto
See“ Lead Service” on page 5




SPECLINK BRINGS SPECIFICATION AUTOMATION TO
NEUMANN/SMITH AND ASSOCIATES

Neumann/Smith and Associates is an award winning architectural firm located in Southfield, Michigan. Their staff of 42 includes
architects, interior designers, spec writers and administrative personnel.

Because money matters on every new building, addition and
interior renovation project, Neumann/Smith & Associates
looks beyond the ordinary to find cost-effective ways to
create extraordinary facilitiesfor their clients. Whether
designing an office building, museum, fitness center, class-
room, library, medical center, place of worship, city hall,
parking garage or custom home, they draw upon their diverse
experience for novel concepts and approaches that can save
hundreds of thousands of dollars. Challenging their creative
vision with practical expertiseallowsthemto givetheir clients
more for their money than they ever dreamed possible ... and
that's smart design.

Thediversity of their experience keeps them thinking “ out of
the box,” inspiring innovative solutions for new and complex
challenges. Their staff’s understanding of issues and trends
in officedesignisinvaluablefor creating awork environment
that is both efficient and enjoyable for their clients. The
personal involvement of their staff, along with an understand-
ing of the devel oper marketplacein Southfield, isan important
component of their total work product.

Their creativity and unwavering commitment to the highest
standards of professional practice have earned the firm over 125
design awards, the Firm Award from A1A Michigan, two Marvin M.
Black Excellencein Partnering Awards from the Associated General
Contractors of America, and numerous featuresin the international
architectural press.

TheNeed: Ron Lindow joined Neumann/Smith and Associatesin
1988. One of hisfirst assignmentswasto bring thefirm’s specifica-
tion system into the “electronic age.” They started using a word
processing-based spec writing system. While it was better than
what they had been using, it was still a protracted process to create
specifications. They had a master document, but any changes had
to be made by cut and paste. Then,

YMCA in Ann Arbor, Michigan is a 70,000 sf
neighborhood recreation center designed by Neumann/
Smith & Associates with the help of BSD SpecLink®.

to create specifications.

The Solution: Theswitch to SpecLink occurredin 2001. Lindow
uses one word more than any other to describe his SpecLink
experience: “Ease.” He saysthe things he likes best about SpecLink
are, “The ease with which you can maneuver within a section, within
multiple sections and multiple projects at the sametime. The ease of
importing information into SpecLink from other sources. The ease of
restoring text that would have been previously deleted. And the
ease of changing the spec when the project requirements change.”
Other things are easier now, too. With SpecLink, he createsasingle
header and footer per project. If he needs to make changes — even
after an edit - it just takes
afew clicksof the

the footers and headers had to be
inserted into every section, and
each section had to be printed
individually. Eventhough it wasa
computerized system, it was not
very automated. It still required a
lot of “manual” oversight. Lindow

simpleto convert.”

“1 would like to compliment SpecLink on the painless conver-
sion to MasterFormat 04. Even our USER sectionswere very

mouse. And, since
SpecLink hastruly
automated his specifica-
tion writing system,
Lindow says, “I can set
up the whole project to
printwhilel’mat lunch.”

Ron Lindow, Specifications Writer
Neumann/Smith and Associates

knew there had to be an easier way

See“ Neumann/Smith” on page 7
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SPECLINK+ STATISTICS: .

627 sectionstotal, 291 updated or new
(46%)

2 new non-proprietary sections

515 non-proprietary sections, 254
updated or new (49%)

112 proprietary sections, 37 updated
(33%)

27 sectionswith built-in checklists
101,590 paragraphs

110,932 internal links (targetsand
consequences)

23,901 notesto specifier

10,087 noteswith live hyperlinksto
Internet web pages

2,114 external documentsreferenced,
19% verified, with live hyperlinksto °
order information

946 ASTMsreferenced, 31% revised

3 obsolete ASTMs removed

182 standards organi zations referenced
2,309 manufacturer listings, with live
hyperlinks to their webs sites

921 unique manufacturerslistedin 357
non-proprietary sections

SHORT FORM SPECS STATISTICS:

16 sections corresponding to
MasterFormat 1995 divisions

7 sections updated (43%)
8,301 paragraphs

821 notesto specifier

8,826 internal links (targetsand
consequences)

e 363 externa documentsreferenced, 19%
verified

e 226 ASTMsreferenced

e 43 standards organizations referenced

PERSPECTIVE PERFORMANCE SPECS

STATISTICS:

e 161 sections, 8 updated (5%)
17,374 paragraphs

e 21,730internal links (targetsand
consequences)

e 3,877 notesto specifier, 24% verified,
603 with live hyperlinks

e 186 externa documentsreferenced, with
live hyperlinksto order information

e 49ASTMsreferenced

e 38 standards organizations referenced m

On-site SpecLink Workshop at RRM Design Group,
San Luis Obispo, CA

SPECLINK WORKSHOPS
YI1ELD BENEFITS

While SpecLink isintuitive and can be
learned without atraining class, anumber of
our users have found the workshop to be well
worth the time and money. Even userswho
have already used SpecL.ink to complete a
project have found the class to be extremely
beneficial. Theworkshop isdivided into two
days — day oneis spent learning how to
navigate the software, edit the specs, format
and print. We also go through the quarterly
update process. Day two is spent on learning
the concepts and skills required to develop
your office master. Theworkshop iscon-
ducted 8 timesayear in our Atlantaoffice,
and qualifiesfor AIA continuing education
credits. If you have three or more people who
need to attend the workshop, it generaly is
more economical for usto cometo your
location.

For more information on the content of the

class go to http://www.bsdsoftlink.com/training/training.htm#SpecLink. The cost of the workshop in Atlantais $495 per person for one
day, and $895 per person for the two day class. For the cost of an on-sitetraining class, call your BSD salesrep at 888-BSD-SOFT (888-

273-7639).
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NEW SPECLINK SECTIONS

07 7200 (07720) - ROOF ACCESSORIES:

Factory-fabricated unit roof accessories except linear flashing-
related items.

This section includes:

e manufactured curbs, equipment rails, and mounting pedestals.

»  roof access hatches, for ladders, ship’s ladders, stairways, and
equipment access.

» smoke and heat activated hatches (vents).

e snow guards, individual and fence type.

Flashing-related items not included are al those that are linear, such
as:

*  Counterflashings.

e Gravel stops and edgings.
»  Parapet copings.

* Fascias.

e Gutters and downspouts.

* Section 07 6200 (07620) - Sheet Metal Flashingand Trim, for
custom-madeitems.

* Section 07 7100 (07710) - Roof Specialties, for manufactured items.
* Section 07 7123 (07631) - Guttersand Downspouts.

Some other accessories that could be specified in this section, but
arenot, include:

* gravity attic vents(also specifiedin 07 7100 (07710).

»  roof membranerelief vents (also specified in 07 7100 (07710).

*  melt-out smoke and heat vents.

* ridge vents (for steep roofing).

»  roof walkways and walk boards, when not provided as part of
the roofing.

»  waste containment assemblies, for roofing.

» roofing ballast and deck pavers (if not specified in their own
section or in the roofing section).

08 3313 (08334) - COILING COUNTER DOORS:

Commercia quality, upward-acting rolling or coiling counter doors
(also referred to as “ counter shutters’).

The doorsin this section are fabricated from steel, stainless steel,
and aluminum, with or without an integral frame and hood, fire- rated
and non-fire-rated, with manual and electrical operation.

Wood counter shutters are not included in this section. m

CONTRACTOR CERTIFICATIONS FOR
LEED CREDITS

Someof the LEED-NC 2.1 creditsare not directly under the
Architect/Engineers or Owner’s control. These arefor procedures,
activities, or materialsthat are usually delegated entirely to the
Contractor. In order to achieve these credits, the Contractor must
not only perform as required, but he must also submit the docu-
mentation necessary to show that the credit was achieved. For
instance, if the waste management credits are to be achieved,
documentation of the amount of waste removed, the amount
delivered to the landfill, and the amounts recycled must be made all
during the construction period — it's way too late at the end to
provethat any recycling or landfill diversion occurred. BSD
SpecL.ink includes submittal requirements and formsfor document-
ing many of these credits.

e SSPrereq1- Erosion and Sedimentation Control: Submittals
in Section 01 5713 (01575) include the Contractor’s plan and
inspection reports.

*  MRCredit2.1& 2.2: Construction Waste Management:
Submittalsin Section 01 7419 (01732) includeaL andfill
Alternatives Proposal, the Contractor’s Waste M anagement
Plan, and Waste Disposal Reports.

* |EQCredit 3: Construction | AQ Management Plan: Submittals
in Section 15 721 (01734) include the Contractor’s Plan, Interior
Finish Installation Schedule, and Test Plans and Reports.

e |EQCredit4.1- Low-Emitting Sealantsand Adhesives. Low-
VOC joint sealantsare specified in Section 07 9000 (07900).
However, adhesives are not typically specified for every
application for which they are used and installers could use
adhesives in applications where adhesives were not
anticipated. So aproject-wide requirement for low-VOC
adhesivesis specified in Section 01 6000 (01600). A special
form is used to get the Contractor’s certification that none
have been used on the project: Section 01 3516.07 (01363)
LEED Prohibited Content Installer Certification. The specifier
should ensure that any adhesives he does specify meet the
low-VOC criteria.

* |EQCredit 4.4 - Low-Emitting CompositeWood: Thisisatotal
prohibition on urea-formal dehyde-containing wood products
and isspecified in Section 01 6000 (01600). Sinceinstallers
could theoretically use wood panel products even if not
specified, aspecial form isused to get the Contractor’s
certification that none have been used on the project: Section
013516.07 (01363) LEED Prohibited Content Installer
Certification. In addition, the specifier should ensure that the
composite wood products he does specify are urea-
formal dehyde-free. [
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“Meter Accounts” continued from page 1

TheRegistration and SettingsDialog

Once registered, you can access and edit all
sectionsin SpecLink, PerSpective and Short
Form. If you install SpecLink using the
network install option, anybody with
access to the network server who has done
aClient Installation can access and edit any
section. When you print sections using the
Reports dialog you will see the current
value of the Meter Account displayed. On
the pull-down list for Print Section, each
section that is not free or part of an annual
subscription will reflect its cost next to the
section name. You can print Draft Copy and
Master Text Copy for any section without
charge. When you print clean copy your
Meter Account will be debited by the cost
of the section you printed. Meter Account
sections cannot be exported to RTF or any
other external format. For more detailed
information, see the current Release Notes
at our User Resource web page at http://
www.bsdsoftlink.com/speclink/

sl _subscribers.htm.

A meter account costs $490 and can be
See® Meter Accounts’ on page 7

A BSD SoftLink® Publication

Editor: Niki Koplowitz

The LinkLine is published by Building
Systems Design, Inc. 3520 Piedmont
Road, NE Suite 415

Atlanta, GA 30305

Permission to use excerpts in other
publications is granted provided the
publisher is notified in advance at 404-
365-8900.

BSD SpecLink, BSD CostLink and BSD
SoftLink are registered trademarks, and
BSD CadLink and BSD LinkMan are all
trademarks of Building Systems Design,
Inc.

Get the latest on BSD by visiting our web
page at www.bsdsoftlink.com

Summary info for Sample Project

Gensial Repost Cover Sheet |
- Project Data

Dwner's Name: |Associaled Panership, nc.

DesionBuilder's Name: |

Dresian Professionals Name: [KYZ Agchitecls

Canlractor's Name: |Builders Specially. Inc.

Project Location: [.él.,ﬂm[._-.

Facility Type: | Residental, Mubiple

Froject Type: |Nm~ Construction

[rate Specficalion o
Vst btk }1418/2005

Specilicaticn Due Date: | 11,158/2005 b
Eid Date: (121572005 x

fippios. Squane Footages; E50,000 G5F

G ]
=
=]
Approwe Construchion Cost; j 4,500,000

Date Speciicabon Last iﬁ
|Jpdated to Master: 111872005 e
Contact Documerts Due Date; iTIJ"IE.-"IUE -

Appiow. Completion Date; | 8 /15/2007 -

v #liow B5D tn Publish Project Dt

o, Cancel |

Summary Info dialog box

“Lead Service” continued frompage 1

release specific project information to BSD
for usein amore detailed lead service. The
reportsthat will be generated will be similar
in scope to those produced by Reed
Construction Dataand McGraw-Hill’s
Dodge Reports. Datafor these more
detailed reportswill be provided voluntar-
ily by SpecLink users on the revised
project datatab of the Summary Info dialog
box, now named Report Cover Sheet. The
type of information that will be gathered
includes project name and location;
owner’sname; architect/engineer’s name;
and facility type, size, approximate cost,
and approximate completion date. In
conjunction, as the tab name suggests,
BSD has created a new optional cover
sheet for the administrative reports that
displaysthisinformation. If the project
information is not entered on the Report
Cover Sheet tab, the resulting cover sheets
will display default entries or blanks.

A checkbox at the bottom of the dialog box

allows BSD to publish and release the
specific project data to participating
building product manufacturers. Clicking to
removethe checkmark will prevent the
specific project datafrom being included in
the lead service reports until the box is
rechecked.

At BSD, we believe activation of this new
capability will work to the advantage of al
parties. Timely release of project datawill
ultimately result in greater competition
between specified manufacturers, benefit-
ing both the project owner and the archi-
tect/engineer. Manufacturerswill be ableto
obtain better and timelier data on projects
for which they have been specified,
allowing them to prepare more competitive
proposals. And BSD will be ableto tap into
anew revenue source that will allow usto
keep product costs down and ultimately to
lower the cost to our users. We anticipate
and welcome your feedback on this new
feature. |
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BSD
Software

ALL ProbpucCTS

s I’velost my update CD or | didn’t
L.] receiveit! What do | do?
Check with the point of contact in

m!  your company to seeif they received
the CD directly. If not, you may be on the
Download only list and the CD was not
shipped to you. If that isthe case, go to our
websiteat http://www.bsdsoftlink.com/
downloadcenter/userspage.htm. Download
thefile to your local drive and then double
click onthefileto start theinstallation. If
you are a SpecL ink subscriber, you will also
need aserial number to compl ete the
installation. That number isslp4457117. You
should also download the Release Notes for
your application because they include

information you will probably need, and
they change every quarter.

V. Canweinstall asingle user license
version on our file server?

Yes, you can use the Network Server
'm! installation and then you can install
asmany Client machinesasyoulike. Your
single user access key will restrict the usage
to oneuser a atime.

SPECLINK+ AND PERSPECTIVE

V' How do | select al paragraphsina
section?

Thereisnoway to select all para-

'm!  graphsin asection at once. If your
purpose is to print out the section for
someone €else to review, what you need to
doisto print the Master Text Copy or Draft
Copy report. Click ontheprinter icon or File
| Print and click on the Down Arrow to the
right of the Report to Print field. If the
section has any user added paragraphs or
edited text choose the Draft Copy. If you
have not done any editing, choose the

Master Text Copy report. Both reportswill
print all paragraphs whether they are
selected or not, and will includeall choice
options for choices. You may also want to
turn on the Master Notes and/or Project
Notes (in Report Options) to print al
available information about the section.
L.] | have several user-added para-
graphsthat | would like to moveto

another section in the same project. How do
| movethem?

The best way to move severa

m\ paragraphs of text at atimeisto drag
across the text of the paragraphs with your
mouse so that they al turn black in the
background, and click the Cut button. (If
they are master paragraphs, and not user-
added, you can choose Copy instead.)
Then, in the section you would like to move
the paragraphs to, click to place your cursor
in the paragraph below where you want the
cut (or copied) paragraphs, and then click
on the Paste button. (You do not need to
insert an empty paragraph before pasting.)
All thetext is copied above where you had
your Ccursor.

e How can | globally change the font
inmy specification?

Go to the Tools menu and select

m!  Customize Styles. Click onthe Fonts
tab and click on the Fonts button to the
right of each level. You can change the Font,
Style, and Sizeinthisbox. Thiswill change
the font for the text within each section. To
change the font in the headers and footers,
choose View | Show Header/Footer, high-
light the header and footer text and choose
thefont from the toolbar in the Customize

Header/Footer dial og box.

L.] | am editing aparagraph with ablue
choice and | do not want any of the

options that arein the choice. How can |

edit the blue choice text?

You cannot edit blue choicetextina
m\ master paragraph. In order to get the
text you want, you will have to copy the
master paragraph. There are two waysto do
this.

Option One: If you want to keep the blue

choice and just add more choices or edit
existing choices, copy the whole paragraph
by placing your cursor in the paragraph so
that it is blinking and click the Copy button.
Then Paste it above or below the master
paragraph. You will be ableto place your
cursor in the blue choice field in your new
paragraph and choose from the Document
menu, Choices, Edit Choice.

Option Two: If you do not want to keep and
edit the blue choice field, then copy only the
text of the master paragraph to anew
paragraph. First create anew paragraph by
clicking at the beginning or end of a
paragraph and pressing Enter. Then drag
across the text of the master paragraph and
click the Copy button. Click in the new
paragraph you created and click the Paste
button. All the text can now be edited.

Be sure to select your paragraph and
deselect or exclude the master paragraph.
You may also want to insert a Project Note
to let subsequent users know which
paragraphs they are supposed to use.

r. | will be creating alot of front-end

documentsfor my office master and |
will need to mention atermin them that
changes from project to project. Isthere
any way to easily change that term without
finding and editing it in each document
whereit appears?

There arereplaceabletermsinthe

m!  Summary Information screen that
you can use to change information through-
out the documents. If the term you need is
not one of those listed, there are keywords
that are not used in any of the master
documents and that you can use for your
terminstead. In PerSpective, the keyword
Design Professional is not used in any of
the sections. In SpecLink, the keyword
Design-Builder is not used in any of the
sections. Just edit the text in Summary
Information to whatever you need. Then,
click in the user paragraph where you want
that term to appear, and from the Document
menu choose Choices...Add Choice. From
the Choice Group Type drop-down, select
the keyword that you used, click the Add
button, and click the OK button. Theterm

Continued on next page
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Continued from previous page

will appear in greentext. If you edit thetext
inthe Summary Information screen, the
green text will update throughout the
project.

e How do | rename/renumber a
section?

I\ Tochange the name of asection,

m'  click onthe name of the sectionin
the Tree panel so that it displaysin the
Document panel. The current name of the
section displays in the Sequence 0000
paragraph in the Document Panel. Drag
across the entire name in the Document
Panel so that it is highlighted then type the
new name over theold name. Click on
another paragraph so that your edit will be
saved. The Tree Panel will update to the
new name and the new namewill print in the
header or footer when the Section Name
keyword is used. Thiswill also update the
name in the automatic Table of Contents
report. If you want to renumber a section,
right click on the name of the section in the
Tree panel. Choose the option to copy or
cut section. Right click on the correct folder
in the Tree Panel and choose paste section.
At this point you will be able to renumber
and also rename the section.

CosTLINK/AE AND CosTLINK/CM

m | am using the Link to Excel feature

to link the quantities of the tasksin
my estimate to the overall size of the project
that | enter in my Excel spreadsheet. When |
change the size of the project, some of the
guantities are decimal values when they
should be whole numbers. For examplethe
number of trees required changes based on
the length of asidewalk, so | created a
formulato calculate the number of trees.
Sometimesthevaueis4.52 trees. | want it to
be 4 or 5. Isthere anyway to do that?

n In Excel, edit your formulato read
m!  =ROUND(your formula,0). Thezero
after the commauwill cause Excel to round to
the nearest whole number. If you want Excel
to aways round to the next higher number
or alwaysto the next lower number, use
ROUNDUPor ROUNDDOWN respectively.
:.] | want to copy just folders from the
assemblies database into my project.
How do | do that?

You can do that by dragging and
m!  dropping using your right mouse
button. Itiseasier if you have both
databases open and tiled vertically. When
you drop the folder into the project data-

base, choose the option Copy Folders Here.
If you do not need all the folders you copied
in, you can use the Delete Empty Folders
option under the Tools menu to remove the
empty folders.

CosTLINK/AE

:.] | don’t see the Modelstab in my
CostLink/AE project. How can|
make use of the modeling feature?
n In order to use any of the 73 RS
m!  Means building Cost Models, you
need to start a project using the template
called Uniformat 11 Project Templatewith
Models.MPJ. Once you have a project
started with thistemplate, you will have
both the Cost Models and the Model

Additivestabsin the Summary Info dialog
box. |

More questions?

Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226
Email: support@bsdsoftlink.com

“Meter Accounts” continued from page 5

replenished at the same price. SpecLink sections cost $7 each to
print. PerSpective sections cost $21, and Short Form sections
cost $35. Up to 50 users can use a single meter concurrently.

“ Neumann/Smith” continued from page 2

The Outcome: Inthefour years since they began using SpecLink,
Neumann/Smith and Associates have created an office master.
Documents (drawings and specifications) in southeast Michigan

When the current meter value is less than the value of a section a
user istrying to print, the user is notified and the section is not
printed. When a meter reaches $0, printing ceases and all

sections become unavailable. You can replenish the meter at any
time and your new purchase will be added to the current value of
the meter. You can also upgrade to a subscription and use it in
conjunction with the value remaining on your meter or apply the
amount on your meter as a credit toward the cost of the subscrip-
tion.

We're working to make it easier to buy and use sectionsin
SpecLink. We want this new service to help you, we welcome any
feedback, and welook forward to working with you.

contain much more information than in some parts of the country. It
has been easy for Lindow to accommodeate this special need in
SpecLink by creating User Sections. SpecLink recently released an
update and Lindow was pleased with the outcome, “1 would like to
compliment SpecLink on the painless conversion to MasterFormat
04. Even our USER sectionswerevery simpleto convert.”

On hisoverall experiencewith SpecLink, hereflects, “ All the
projects|’vedonein SpecLink aremy BEST projects. | promoteits
use to professional associates at other firms whenever the opportu-
nity arises.” Y
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Training Schedule

TheBSD SpecLink+
Wor kshop

TheBSD SpecLink+ Workshop consists of
two one-day workshops. The first day is
devoted to learning the basics of
SpecLink+, including how to navigate
withinthe software, start anew project, edit
sections, understand how the links and
choiceswork, and how to format, print and
export the final document. It is designed
for new users. The second day isdesigned
for those who want to learn how to create
and maintain their own officemaster. This
day covers the concepts of an office mas-
ter, how to customize your master by add-
ing choices, links, and tags, aswell ascre-
ating your own checklists. Users must al-
ready be familiar with the basics of
SpecLink+ to attend the second day.

BSD SpecLink+
Either Day* $495
Both Days* $895

Dec6-7
Jan 10-11
Mar 14-15

AlIA Members: We will report your course
completion for 7 or 14 Continuing Education
Units
CSI Members: Submit Course Completion
Certificate for 7 or 14 Education Contact
Hours (ECHSs) toward your CCS, CCCA, or
CCPR Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

BSD CostLink/CM
3days* $1295

December 13-15
March 7-9
June 20-22

AlA Members: Submit Course Completion
Certificate for 24 Continuing Education Units
CSI Members: Submit Course Completion
Certificate for 24 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR
Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions & information on travel, hotels, & Atlanta!

PABSD

Building Systems Design, Inc.

3520 Piedmont Road, NE
Suite 415
Atlanta, GA 30305
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